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Running Studio 16 Before Partitioning Your Hard Drive

Because Studio 16 is very hard disk read/write intensive, it is very important to create
a partition on your hard drive dedicated to your working audio files. If you've just
received your AD516 or AD1012, and would like to try it out before you backup and
partition your hard drive, you can safely run Studio 16 by recording into memory.
When Studio 16 was first installed it set your record path to RAM:. This means that
all recordings will be made directly to your memory - not to your hard drive. Check
the Sample List for your record path. It is indicated by a [X] next to a path name.
Make sure RAM: is the selected record path if you have not partitioned your hard
drive.

Partitioning Your Hard Disk

Studio 16 can use any Amiga DOS device to record and playback from, (i.e. DFO:,
DHO:, RAM:, etc.). And, unless you are recording to RAM:, Studio 16 is very hard
disk read/write intensive. Therefore, it 1s very strongly recommended that you create
a separate partition on your hard disk for your audio files you are recording, editing,
and playing. If your Amiga crashes while a write is in progress, you may have to
reformat your hard disk. If you have partitioned your hard disk and a crash occurs,
you will only lose your "working" audio partition. You will not lose anything
valuable, i.e. programs and archived samples.

When naming your Audio partition, do not name it Studio16 or Studio16_3. This will
confuse the system since there is a Studio 16 assign. Tutorials in this manual refer to
the partition as if it were named "Audio”. You may want to name your partition
"Audio" as well.

NOTE

SunRize is not responsible for lost data. Partition your hard drive!

Reselection

If you are working with a single hard disk, turn "Reselection” OFF. If you are using
more than one Hard Disk, you should have "Reselection” ON. Your version of
WorkBench, the controller your using will determine how to turn Reselection OFF.

Commodore Controller - WB 2.0
1. Insert the WorkBench 2.0 Install disk into your floppy drive.

2.  Select the Tools drawer

3. Select Turn Reselection OFF if you have just one hard disk.

Commodore Controller - WB 3.0
1. Insert the WorkBench 3.0 Install disk into your floppy drive.

2. Select the Tools drawer.
3. Select English.
4. Select Turn Reselection OFF if you have just one hard disk.
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Third Party Hard Disk Controller

1. Refer to your hard disk controller manual for instructions.

Set Your Record Path

A Record Path 1s the assigned location for your new audio recordings. The default
path 1s RAM:. Once you have partitioned your hard disk, you will want to change the
record path to a directory on the hard disk. Your record path should be located on
your Audio partition.

The following changes the record path from RAM: to a directory on the hard disk.

1. Select Sample List from the Applications Menu (*O).

2. The Sample List appears with RAM selected as the record path, note the

selection box next to the path name.

3. To add another path to Sample List, select Add New Path from the Sample List

menu. Select your new path from the requester and click OK.

4. Sample List will update and display the two directories. You can continue
adding paths (up to eight) to suit your setup. Remove the RAM: path by
selecting Remove Path from the Sample List menu and selecting it in the

requester.

5. Once you have all your paths listed, choose one for the record path by clicking
the active box next to its name. You can change this selection at any time.

6. To save the Sample List setup, select SaveSetup from Project menu. This will
also save the positions of the windows on the screen. If you don't want Sample
List showing every time you run Studio 16, close Sample List before you

SaveSetup.
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Figure 2-4.

Sample List
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Studio 16 File Structure

Studio 16 requires the following directories of files to operate. They are
automatically copied by the installation utility into a Studio16 directory.

Apps
Drivers
Utilities
ProjectMenu
Fonts

Libs

Studio 16 should have an assign called "Studiol16_3:" that points to the created
Studio 16 directory. The installation utility will add this assignment to your User-
Startup. It you move the Studio 16 directory later, be sure to update the assignment in
your User-Startup file.
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Getting Started

This chapter is a brief tutorial on using basic Studio 16 options. Included is a
description of common screen elements and short tutorials on recording, editing and
playing a sample. Detailed information on all modules is provided in Chapter 8, the
Reference Section of this manual.

[t 1s recommend that you open and read the Read_Me file in the Studio 16 directory
before loading Studio 16. This file includes updated information not found in this
manual.

Load Studio 16

|.  Double click the Studiol6 icon in the Studiol6 drawer. For more detailed
instructions see Chapter 2 - Installation.

2. An About window appears listing the amount of disk space available in your
detault record path. It also displays the amount of chip and fast RAM installed in
your system. Click OK to close it.

Menus and Keyboard Shortcuts

Studio 16 Modules can be launched from the Applications Menu or from the
keyboard. To select a module from a menu, click the right mouse button and hold it
down. Move the mouse pointer over a menu option and release the mouse button to
select it.

Keyboard shortcuts are identified in the menu to the right of the option name.
Module shortcuts use the control (Ctrl) key, indicated by( * ). All other keyboard
shortcuts will use the Right Amiga Key( A- ). To use a keyboard shortcut, hold down
either the Control key or the Right Amiga key, and type the letter indicated.

The key to using software efficiently is to memorize the keyboard shortcuts for your
most common applications.

Once a Module is launched it may add more menus to the menu bar. For a module's
menu options to be available and to use its keyboard shortcuts, you must first make
the window active by clicking on it. The title bar of a window will be highlighted
when it is active.

NOTE

OK requesters can generally be accepted or rejected with the standard keyboard
shortcuts. For OK, Left A-V. For Cancel, Left A-B.
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Common Screen Elements

Most screen elements are common to the Amiga Intuition standard; however, there
are a few gadgets that you may not be familiar with.

Drop List

Indicated by a ¥ , allows you access to available choices for an option. Click the N
button for a list to appear below the current selection. Use the familiar scroll bar and
arrow buttons to locate a new selection. Click on an 1tem to select it.

Active Boxes

Many options can be turned on by activating them. Click the active box next to the
option's label. Deactivate it by clicking the button a second time or by selecting
another option.

Window Zoom

The Window Zoom gadget provides a quick way to switch between two different
window size/position settings It is a toggle that ,when selected, makes a large
window small and a small window large.

Depth

Located in the top right corner of all windows, the Depth button allows you to bring a
window to the front or move it to the back. Click the button once to move 1t to the
front. If the window is already in front, the single click will move it to the back or
underneath all other windows. Also selecting a module from the Applications Menu
will bring it to the front. If ClicktoFront is selected in Preferences, this button will not
appear. Windows are brought to the front by clicking anywhere on them when the
ClicktoFront option is selected.

Resize

In the lower right side of most windows is a small triangle. Click and drag this
triangle to resize a window. As windows are reduced in size, text in the window and
title bar will truncate.

Record and Play

Once you have installed and loaded Studio 16 you are almost ready to record.

Before you can record, you need to connect your audio source. Any audio source
with a "Line Out" may be used, preferably a CD player. Use a short RCA patch cable
to hook up the CD's Line Out to the AD516's or the AD1012's Audio IN jack(s). If
your audio input is from a microphone, you will need an external device, like a
mixer, to convert the mic output into an RCA Line Out. The card's Audio OUT
jack(s) can be hooked up to a receiver or an amplifier system's CD/AUX Line In. If
you have a LTC SMPTE time code source, plug it into the top jack: SMPTE IN.
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Now that you are ready to record, there are two methods of recording. One uses the
Recorder module and the other records from the Cue List. For this brief

demonstration of recording, the Recorder module is used.

Record with Recorder

. Load Recorder, Sample List and Meters from the Applications Menu. Close any
other modules that are open.

2. Check your record path in Sample List. If you have not partitioned your hard
drive, it should be set to RAM:. (The record path is identified by a x.)

3.  Turn on your audio source.

4. Click Monitor in the Recorder window. You should hear the audio playing
through your output device.

5. ADS516 ONLY - To make a stereo recording, select the L and R channel from
the Recorder Menu so that both channels have a check next to them. To make
selections from the Recorder Menu, make sure the Recorder window is

highlighted. You should have audio connected to both of the AD516's audio
inputs when recording in stereo.

6. Activate Meters by clicking on the window. From the Meter's Channels Menu,

select Input, Output and Play 1. These are easily selecting by holding down the
right mouse button, and clicking the channels with the left mouse button. You
will now see activity on the input and output meters.
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Figure 3-1. Meters and Recorder

7. Set the proper Gain in the Recorder setting by watching the meters for clipping.
Clipping results from the gain being set too high. It is indicated on the meters by
the VU meter going into the (+) section, the LED meter flashing on the far right
side, and the scrolling graph meter peaking off the top and bottom. Adjust the
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Gain so that clipping rarely, if ever, occurs. See the Meter Reference Section for
more information.

8. ADS516 ONLY - Stereo samples will be shown in the scrolling meter by channel.
The input from the left channel will be graphed on the top of the graph, and the
input from the right channel will be graphed on the bottom of the graph.
Disconnect one of the inputs to see the effect on the scrolling graph.

9. ADI1012 ONLY - AD1012 owners have the option of setting a variable lowpass
filter. Activate Auto Filter to set an appropriate cutoff filter for your sampling
rate. (The AD516 has a digital filter. It's automatically activated whenever you
record.)

10. Select a sampling Rate. Keep in mind that 44.1KHz is the CD standard and
48KHz 1s the standard rate for DAT players. Anything more than that does not
have an audible effect. For video purposes you may want to record at about
32KHz. This gives a 16KHz frequency response, more than adequate for

narration and sound effects. (The nearest available sampling rate for the AD1012
is 30,120Hz.)

1. Click the Name button and type in a name for your sample. The default is
Untitled.

i

NOTE You can name the sound before you start recording, or you can rename the sample in
the Sample List later.

12. To begin recording, click Record. A window will appear in the middle of the
screen indicating that recording is in progress. Also displayed is the name(s), the
size of the sample recorded so far, and the remaining disk space. These numbers

will change as the record proceeds. And, unless you're recording to RAM, your
hard disk light will flash.

B R R B R T R L R R T T T TR T TR N R T EEETT TR RIT TIR o mmms Tt LT m A mamamam nE e wm

i e = "
- S St

%% ?E AEER N R w—‘ﬁ.xﬁi bt :
* bhdei S e R
G 3 dans % T G T LB SN il Babir e e it
a-wa:ﬁ- 5 %!LE - -\.a_.ﬁ L S M % 2 i

B T R S - -ﬁ:& EE -E_ E SR

b b BACR Cand o kY e 1 i

e A i et kLl iy

H o L e B e 3k 4 i

D BT v R e :::c-.-*?-ﬁ 25 i f ERmaE

+ e e T e _!':Ha:ﬁsﬁ-:b G i

: B A e R e R

e kg.:,;f_,_.-g;g:ca e ke 2 B xwwi%:.si.m# s

Figure 3-2. Recorder's Progress Indicator

If you have SMPTE time code plugged into the AD516 or AD1012, the recorder
will show the time your recording began. Later, if this sample is loaded into the
Editor or the Cue List, this SMPTE time code will enter itself with the sample.
13. To stop recording, click the Stop button. If you continue to hear sound, it is the i
monitoring of the audio source. Click the Monitor button to stop monitoring.
The "monitor" and "record” functions are independent. Also, your hard disk light

may continue to flash for a few seconds after selecting stop. This is normal.
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Play from Sample List

There are a few ways to play back a sample. To play back from Sample List:

.

5.

Launch Sample List from the Applications Menu, (* O). (You can close any
other modules that are open.)

Select the sample you recorded earlier by clicking on 1ts name. It will be in the
active directory. The active directory, or record path, is indicated by .

ADS16 ONLY - To playback a stereo sample, you need to select both the
samples that were recorded, (e.g. Untitled_L and Untitled_R). Select both
samples by shift-clicking. (Holding down the shift key while clicking on multiple
sample names.)

Play the sample(s) by selecting Play Sample from the Sample List menu or by
typing A-P.

To stop the playback early, select Stop Playback, A-S.

NOTE

When playing back multiple samples, all samples must have the same sampling rate.
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Figure 3-3. Sample List

Edit a Sample

To make changes to a sample, it must be loaded into an editor. This part of the
tutorial covers basic navigation within the editor and use of the non-destructive cut,
copy and paste.

Load a Sample Editor

1.
2.

Load Sample List from the Applications Menu (* O).

Select the sample you want to edit and select Edit Sample from the Sample List
Menu or type A-E.

AD516 ONLY - To edit a stereo sample, select two samples in the Sample List
(ending in _L and _R ) by shift-clicking and then select Edit Sample (A-E)

An Edit window will appear with your sample(s) graphed.
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5. Select Play All from the Editor Menu to hear the sample (A-P). The keyboard
shortcut A-P is one the most useful short cuts, it causes samples to play in many
of the modules.

Copy a Range and Duplicate It Within the Sample

1. Mark a range over the area of the graph you want to duplicate. To mark a range,
click on the graph and drag the pointer to the left or right. To alter the size of an
existing range, click on one edge of the range and drag it to a new location.

2. Select Play Range from the Editor Menu (A-L) to hear the marked range.
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Figure 3-4. Edit Window

3. Select Non-Destructive Copy from the Edit Menu.

4. Click on the graph to select an insertion point for the copied range.

5. Select Non-Destructive Paste, and Insert at Start, (A-V). (Start refers the
beginning of the marked range. When you just click on the graph, you create a
very small range.)

6. Click Play All to hear the new version of the sample. Undo Last will return the
sample to its previous state.

NOTE

Because the previous copy and paste were Non-Destructive edits, Undo Last is able
to cancel the change. Destructive edits are not reversible. Having a choice between
destructive and non-destructive editing allows you to have more control over your
samples. Destructive editing actually changes the data on your hard drive as you alter
a sample 1n the editor. However, Non-destructive edits do not destroy data on your
hard drive. It just remembers which edits you want to perform on the sample. Non-
destructive edits can be made permanent and free hard disk space by selecting Make
Permanent. See the Reference Section on the Editor for more information.
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Delete a Range

1. Mark arange to delete using the previous technique.

2. Select Non Destructive Delete from the Edit Menu, (A-D). Since the delete is

non-destructive, it will not erase data from your hard disk. To free hard disk
space, use the destructive delete or select Make Permanent after doing the non-
destructive delete.

Create a Region

Regions are named ranges within samples. Once created 1n the Editor, they can be
dragged and dropped into the Cue List for playback.

. In the Editor, select a range to be named as a region. For details on marking
ranges refer to the technique mentioned previously in this section.

2. From the Editor’s Options Menu, activate Show Regions. An Editor Regions
List will appear.

3. With Editor Regions List active, a Region Menu 1s available in the Menu bar.

4. Select Add Region from the Region Menu to create a region from the marked
range in the Editor.
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Figure 3-5. Editor Regions List

5. When prompted, enter a name for the region.

You can now drag this region into Cue List for playback. (Regions can also be
dragged from the Sample List. Show Regions must be activated from the Sample
List menu for regions to be displayed there.)

Convert a Sample

When a sample is recorded it is usually stored in the Studio16_2.0 file format. This
default format is selected in Preferences from the Project Menu. Studiol6_2.0, like
AIFF, is a 16 bit format. It includes special data that keeps track of non-destructive
edits and marked regions. To export a sample to another audio program you will
probably have to convert to another file format. Studio 16 will convert to:
Studio16_1.0. AIFF 16bit, IFF_8SVX, AIFF 8bit, and RAW. Below are the steps to
convert a sample to an IFF_8SVX format.

1. Load Sample List from the Applications Menu (*O).
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